**Video Article**

**Murine Model for Non-invasive Imaging to Detect and Monitor Ovarian Cancer Recurrence**

Natalia J. Sumi¹, Eydis Lima¹, John Pizzonia², Sean P. Orton³, Vinicius Craveiro¹, Wonduk Joo¹, Jennie C. Holmberg¹, Marta Gurrea¹, Yang Yang-Hartwich¹, Ayesha Alvero¹, Gil Mor¹

¹Department of Obstetrics, Gynecology and Reproductive Sciences, Reproductive Immunology Unit, Yale University School of Medicine
²NatureMost Laboratories
³Bruker Preclinical Imaging

Correspondence to: Ayesha Alvero at ayesha.alvero@yale.edu

URL: https://www.jove.com/video/51815

DOI: doi:10.3791/51815

Keywords: Cancer Biology, Issue 93, ovarian cancer, recurrence, in vivo imaging, tumor burden, cancer stem cells, chemotherapy

Date Published: 11/2/2014


**Abstract**

Epithelial ovarian cancer is the most lethal gynecologic malignancy in the United States. Although patients initially respond to the current standard of care consisting of surgical debulking and combination chemotherapy consisting of platinum and taxane compounds, almost 90% of patients recur within a few years. In these patients the development of chemoresistant disease limits the efficacy of currently available chemotherapy agents and therefore contributes to the high mortality. To discover novel therapy options that can target recurrent disease, appropriate animal models that closely mimic the clinical profile of patients with recurrent ovarian cancer are required. The challenge in monitoring intra-peritoneal (i.p.) disease limits the use of i.p. models and thus most xenografts are established subcutaneously. We have developed a sensitive optical imaging platform that allows the detection and anatomical location of i.p. tumor mass. The platform includes the use of optical reporters that extend from the visible light range to near infrared, which in combination with 2-dimensional X-ray co-registration can provide anatomical location of molecular signals. Detection is significantly improved by the use of a rotation system that drives the animal to multiple angular positions for 360 degree imaging, allowing the identification of tumors that are not visible in single orientation. This platform provides a unique model to non-invasively monitor tumor growth and evaluate the efficacy of new therapies for the prevention or treatment of recurrent ovarian cancer.

**Video Link**

The video component of this article can be found at https://www.jove.com/video/51815/

**Introduction**

Animal models are indispensable tools in life science research. In cancer particularly, data acquired from animal studies provide the necessary information required to initiate the testing of novel diagnostic or therapeutic applications in humans.¹,²,³ Animal models for solid cancers are classically established subcutaneously as it provides an easy means to measure tumor burden and evaluate treatment efficacy without having to sacrifice the animals. Indeed, intra-peritoneal (i.p.) models require that animals be sacrificed to detect and measure any changes in tumor growth. However, for i.p. cancers such ovarian cancer, orthotopic models offer the advantage of studying the disease in its proper environment.¹,⁴ For such a model to be of use in the evaluation of anti-tumor activity, non-invasive imaging methods need to be developed that allow quantification of i.p. tumor burden in live mice.

A major challenge in the use of i.p. animal models is the difficulty in accurately quantifying tumor burden by physical examination. Accurate quantification of i.p. tumors usually require the mice to be sacrificed for dissection. This approach requires the use of high number of animals, which would be sacrificed at different time points. In addition to the cost, it introduces high data variability due to inherent variations within each animal. Non-invasive in vivo optical imaging provides a more fitting approach to monitor i.p. tumor burden in live mice.

Several non-invasive imaging methods are currently used in pre-clinical research for the monitoring of tumor growth and therapeutic responses. These include computed tomography (CT), ultrasound (US), magnetic resonance imaging (MRI), positron emission tomography (PET), and optical imaging such as fluorescence and bioluminescence.⁵,⁶,⁷,⁸-¹² CT is a transmission imaging process combining X-ray and computer technology. It produces a cross-section image of detected beams of high-energy photon, which passes through the body with different speed. US is a type of reflection image, which sends high-frequency sounds to the body creating sound waves that are reflected with different speed depending on tissue density and recognized by the computer to produce a visual image. MRI and PET are emission imaging modalities that use magnetic energy and nuclear particles, respectively to produce the image. MRI creates a strong magnetic field that induces cells to produce their own radio frequencies, which are used to create an image while PET requires a sensitive camera to detect the radioactivity of the administrated...
labeled 2-fluorodeoxy-D-glucose \textsuperscript{7,9,11}. Finally, optical imaging is based on the detection of the emission light of bioluminescent or fluorescent reporters or probes \textsuperscript{8,12}.

In this report, we describe the use of fluorescence, which offers a few advantages over the other types of imaging modalities. With fluorescence imaging, cells can be genetically engineered to express fluorescent proteins constantly without requiring the addition of a substrate or ligation-based probes, which are requisite for bioluminescence and magnetic resonance imaging, respectively. Fluorescence reporters also typically express a brighter signal thus allowing the use of a less sensitive detection method \textsuperscript{8,12}. In addition, with fluorescence imaging, it is possible to detect tumors smaller than 1 cm, which is not achievable with CT \textsuperscript{7,9}. Finally, in contrast to bioluminescence, fluorescence signal does not require an aerobic environment and hence the signal is not limited in hypoxic environments, which are usually occurring in the cores of large tumors \textsuperscript{13}.

However, as any other technology, fluorescent-based imaging methods have its disadvantages. One of which is the inability of the machine-generated low energy photons to penetrate to a sufficient depth. Thus, to minimize the amount of diffused tissue photons the animals should be imaged at different angles. We describe a protocol to establish an i.p. ovarian cancer in nude mice and an approach for i.p. tumor monitoring that provides whole animal imaging through rotation. The rotator angles the mouse to specific and repeatable positions decreasing the tissue interference that often occurs between the light source and the detector. This optimizes the visualization of smaller tumors that may otherwise be missed.

### Protocol

The Yale University Institutional Animal Care and Use Committee approve all the in vivo work described. Sample collection was performed with patient consent and approved by the Human Investigations Committee of Yale University School of Medicine.

#### 1. Preparation of Human Ovarian Cancer Cells

1. Before preparing the cells make sure all materials required for the intra-uterine injection described below are ready and easily accessible. Inject the cell suspension as soon as it is ready.
   1. Grow fluorescent-labeled cancer cells in culture. We use an F2-generation of human CD44+/MyD88+ epithelial ovarian cancer cells, which we previously demonstrated to harbor stemness properties such as tumorigenicity, chemoresistance and high capacity for tumor repair \textsuperscript{14-16}. These cells were generated to stably express mCherry fluorescence (F2-mCherry, Fig. 1) using lentivirus produced from the polyethylenimine (PEI) protocol \textsuperscript{20,21}.

2. On day of injection, harvest the cells by trypsinization and wash once with phosphate buffered saline (PBS).
3. Determine cell count and suspend the cells at 3 x 10\textsuperscript{5} cells/ 50 µl in appropriate growth media. For the ovarian cancer cells we use RPMI 160 with 10% FBS. Keep the cells in the incubator until ready to inject but do not keep longer than 15 min. This is enough for one mouse injection.

#### 2. Intra-uterine Injection of Human Ovarian Cancer Cells in Athymic Nude Mice

Note that the following procedure requires assistance from a second person. In addition, since this is survival surgery, use sterile surgical instruments. This survival surgery procedure should take approximately 10 to 15 min.

1. Anesthetize the mouse using 2% isoflurane. 7- to 8-week-old athymic nude mice is typically used.
2. Verify that the animal is completely anesthetized by pinching the foot pad using fingers or forceps. The animal should be completely non-responsive to the pain prior to starting the surgery.
3. Place the anesthetized mouse ventral side up on a sterile gauze pad with the head away from the investigator.
4. Apply ointment on eyes with a cotton-tip applicator to prevent dryness while under anesthesia.
5. Immediately insert the head in a nose cone system connected to an isoflurane vaporizer (Fig. 2A). This delivers the anesthesia throughout the surgical procedure.
6. Disinfect the left (or right) side of the abdomen using alcohol pads (Fig. 2B) followed by iodine then place a sterile surgical drape over the surgical site.
7. Using sterile surgical scissors and forceps make a 1-2 cm skin incision on the lower left quadrant of the mouse (Fig. 2C).
8. Lift the muscle and make an incision in order to reach the peritoneum.
9. Dissect the oblique muscle to expose the abdominal cavity.
10. Locate and identify the left uterine horn (Fig. 2D).
11. Using sterile hemostat, clamp both anterior and posterior sides of the horn (Fig. 2E). Place the anterior clamp right below the fallopian tube and the posterior clamp right above the cervix.
12. Have the second person inject the cell suspension. Place the needle containing cells, at 45° angle perpendicular to the horn (Fig. 2F). Very slowly inject 50 µl of cell suspension into the lumen of the uterine horn.
13. Remove the needle and release the anterior clamp.
14. Release the posterior clamp and replace the uterine horn in the abdominal cavity.
15. Close the peritoneum using a synthetic absorbable suture and close the skin using a tissue adhesive.
16. Remove the mouse from the nose cone and place back in the cage. If necessary, change the beddings to ensure a clean cage after the surgery. Make sure all animals are awake and active before leaving unattended.
17. Provide ibuprofen at 0.11 mg/ml of drinking water for the first 48 hr post surgery. Afterwards, replace with regular drinking water.
   1. Note: that if athymic nude mice are used and the skin is closed using tissue adhesive instead of sutures, it is not necessary to separate the mice after surgery. SCID mice are more aggressive and may have to be separated.
18. Closely monitor the site of incision for possible infection due to open wound.
3. Detection of Early Stage Intra-peritoneal Ovarian Cancer by Live In Vivo Imaging

Determine the presence of intra-peritoneal i.p disease by live in vivo imaging. A Multimodal Animal Rotation System (MARS) is used in this protocol.

1. Access the MARS capture software from within the MI software. This module provides coordinated control of the MARS capture settings while leveraging the imaging system’s capture and analysis capabilities. Optimize individual capture settings for each modality using a single-view imaging prior to developing the rotation protocol in step 3.4.

2. Input predetermined capture values. For fluorescence capture, use 10 sec exposure, 2 x 2 binning, f-stop 2.8, FOV 120 mm, ex: 550 nm, em: 600 nm filter capture setting. For X-ray capture, use a 10 sec exposure, 2 x 2 binning, f-stop 2.8, FOV 120 mm, 35 kVp, 0.4 mm Al filter capture setting.

3. Save the parameters in step 3.2 as individual session files.

4. Create a rotation sequence protocol by selecting the Create/Edit Protocols button from the system interface acquire window.

5. Select the previously saved fluorescence session file and save as Step One. Next, select the corresponding X-ray session file and save as Step Two.

6. With Step One selected, use the Set Rotation Series from the Before Image Capture pop-up menu to set the desired starting angle, range, and increment to ensure for seamless visualization of features. The specific values include a starting angle of -180 degrees, a range of 375 degrees, and an increment of 15 degrees.

7. Save the protocol and click the Done button to initialize the MARS and map the stepper motor positions corresponding to each of the angle increments.

8. Perform the final calibration as described below to align the ventral, dorsal and lateral views for the specific animal positioned in the animal support with specific degrees of rotation to be used by the software protocol.

9. Anesthetize the mouse using a mixture of medical air and 2% isoflurane at a flow rate of 2 L/min.

10. Start the alignment by selecting the Preview button from within the Acquire menu to bring up the Rotator tab. Use the reflective light modality rather than the multiwavelength or X-ray modalities to expedite the process.

11. Select the Load Mouse option and proceed through the series of positioning menus.

12. Ensure that the tubed end of the collapsible nosecone is in the nosecone recess and place the mouse in the prone orientation with its head in the nosecone.

13. Begin the calibration at the 0 degree position with the ventral side of the animal facing down. Use the two knobs on the rotation system to position the animal so that it appears centered in the Preview window.

14. Repeat the process as prompted for -180, -90, +90, and +180 degree positions and click Done.

15. Execute the previously saved protocol by clicking the Execute Protocol button from the main acquire window. During the execution of the protocol, observe a status window providing real time status updates for the Current Capture, Exposure Duration, and overall Protocol step.

16. Assemble individual images into a movie format using the Rotation software. Use the Display Controls to adjust brightness/contrast, transparency, and to set the display color for the fluorescence signal.

17. Export the final sequence of images in the *.AVI file format for presentation.

4. Administration of 1st and 2nd Round Chemotherapy

1. Following i.p. tumor detection by MARS, determine the initial tumor burden region of interest (ROI) using standard two-dimensional positioning. This is performed on a transparent animal tray fitted in the imaging system as described below in Section 5. Once initial ROI is determined, administer 4 doses of 12 mg/kg Paclitaxel i.p. every three days. Paclitaxel is obtained from Hospira Inc. in a ready-to-go formulation with cremaphor as vehicle. We previously demonstrated that this treatment regimen has significant anti-tumor activity against the xenograft model compared to vehicle control and induces complete eradication of detectable tumor burden. However, due to the nature of the disease, i.p. tumors recur a few days after treatment ends.

2. Monitor response to treatment by imaging every 3 days using standard two-dimensional positioning.

3. After the fourth dose of Paclitaxel, classify the mice as having complete response (ROI less than 2,000), partial response (up to 35% decrease from the initial ROI obtained from step 4.1), stable disease (up to 50% increase from the initial ROI), or progression with treatment (more than 50% increase from initial ROI) based on the fluorescent signal observed.

4. For mice with complete response, monitor recurrence by imaging every 3 days. Once recurrence is observed (ROI = to initial ROI in step 4.1), re-initiate the second round of Paclitaxel as described in 4.1.

5. In mice with partial disease, stable disease, or those that progressed with treatment, re-initiate second round of Paclitaxel 3 days after the 4th dose of Paclitaxel. Similarly, image these every three days.

5. Monitoring Response to Treatment Using Standard Two-dimensional Positioning

1. Anesthetize the mice to be imaged using a mixture of medical air and 2% isoflurane at a flow rate of 2 L/min.

2. Place the head of the anesthetized mice in individual nosecones in the transparent animal tray within the imaging chamber (Fig. 3).

3. Input the predetermined exposure parameters for fluorescence (10 sec exposure, 2 x 2 binning, f-stop 2.8, FOV 120 mm, ex: 550 nm, em: 600 nm) and X-ray (20 sec exposure, 2 x 2 binning, f-stop 2.8, FOV 120 mm, 35 kVp, 0.4 mm Al filter).

4. Click Expose to capture both images in sequence.

5. Open the images in the Bruker MI software for visual inspection and region of interest analysis.
6. Image Overlay and Analysis

To provide a valid comparison for both visual and quantitative analysis of the time course image sequence process all foreground and background images similarly.

1. Open both the foreground image (i.e. fluorescence) and the background imaging in the software and select the tile function from the Window menu at the top (Fig. 4A).
2. To process the foreground image; open the Image Display tab on the top bar (Fig. 4A, red arrow) and set the min/max values to 260 and 5,000, respectively (Fig. 4A, blue arrow)
   Note: Image Display range differs from study to study depending upon the fluorescence signal intensities captured in images. Images should be contrasted with a min/max that will show tumor masses, yet not show background from autofluorescence of the animal.
3. Next open Auto-ROIs Tab from the Navigation Panel on the left (Fig. 4B, red arrow) and select the New ROI Set from the menu (Fig. 4C, red arrow). Adjust the settings to use the Threshold algorithm at 630 grayscale levels and deselect the Restrict size Max to ensure all potential ROI’s are recorded (Fig. 4C).
   Note: Threshold settings may differ from study to study depending upon the fluorescence signal intensities captured in images. Images thresholded to quantitate signal from tumor masses yet not measure signal from background from autofluorescence of the animal.
4. From within the Image Display Window select the Mask function. Now only the area corresponding to the pixels that have values equal to or exceeding the threshold value of 630 grayscale levels will be displayed.
5. To view the quantitative results select the Analysis tab from the top menu bar and the select the display tab (Fig. 4D, red arrows).
6. From the Display menu select the Serial Number, Sum, Mean, and Area check boxes and then click OK.
7. Save the image so the values can be exported along once all fluorescence images are processed.
8. Next, highlight the X-ray image and again open the Image Display from the top menu bar. Set the values for min, max and gamma to give the best visual representation of the mouse skeleton.
   Note: Since no quantitation is performed on the X-ray images each individual X-ray image from the time sequence can be processed (i.e. min, max and gamma values) to produce the best looking representation of that data set.
9. Again with the X-ray image highlighted select the Overlay check box and choose the corresponding fluorescence image file name from the drop down menu (Fig. 4E).
10. To extract the overlaid output, select the Annotations tab from the Navigation menu (Fig. 4B, blue arrow) on the left. Select appropriate tabs to add any additional data or text and finally add the intensity scale bar so the fluorescence intensity data can be quickly determined from the image.
11. Once the annotations are completed highlight all the objects on the Annotations page and select copy from the Edit menu at the top and paste the overlaid image data into the appropriate file (e.g. Word, PowerPoint, and/or Photoshop) for display.
12. Repeat Steps 6.1- 6.11 for all pairs of fluorescence and X-ray images in the sequence. Be sure to safe all images before closing them.
13. For final quantitation open all the fluorescence images at the same time and select Tile from the Window menu along the top.
14. Next select the Export All Open Documents to view the data.
   Note: In absence of Excel program, deselect the tab. MI will generate a tab delimited text (i.e. .txt) file that can be transferred to an appropriate computer for further analysis.

Representative Results

Non-invasive live imaging allows the monitoring of i.p. tumor progression from the same mice through time. Intra-uterine injection of mCherry-labeled F2 ovarian cancer cells using the described protocol generates visible i.p. tumors at day 5 and carcinomatosis at day 32 (Fig. 5). Figure 6 shows the correlation of the obtained images with carcinomatosis observed after sacrificing the mice.

Imaging using MARS allows the detection of i.p. tumors that will otherwise be missed if image is acquired from only one single plane. Figure 7 (top panel) shows that even in Control mice with significant tumor burden, tumor size can be underestimated depending on the angle the image was taken from. The ability to ensure that tumor mass is not missed or underestimated is even more important at the conclusion of 1st round chemotherapy when animals are categorized as either a complete responder, partial responder, or non-responder (Fig. 7 middle panel). Similarly, during maintenance therapy it is of utmost importance to detect very small recurrent tumors to properly designate days to recurrence, which defines progression-free interval (Fig. 7 middle panel).

Quantitative assessment of tumor burden is optimized through animal rotation. Rotation of the animal to angles that will minimize the depth excitation and emission light travels through will allow for the most accurate capture of photons from the fluorescence, which is indicative of the quantity of tumor cells and thus tumor burden. Hence, quantitation is optimized for specific tumors in the animal depending upon its position in the rotation sequence.

In presenting images of rotation data sets, it is important to assign the images a min/max image contrast range that will effectively display all tumor masses, while allowing for visual delineation of individual tumor masses. For this study, ideal contrast range was found to be a minimum of 50 counts and a max of 1,200 counts. These values can be seen as a guideline for other studies, however, optimal contrast ranges will differ from study to study depending on tumor burden level, fluorescent peptide expression levels in cells, imaging system configuration, and capture settings.
Figure 1: F2 ovarian cancer cells stably express mCherry fluorescence. (A) Phase image; (B) fluorescence image; (C) overlay of A and B. Note that 100% of cells express the fluorescence reporter.

Figure 2: Intra-uterine injection of ovarian cancer cells. (A) anesthesia is continuously administered via a nose cone; (B-E) skin is incised to locate and clamp the uterine horn; (F) cancer cells are injected slowly into the lumen of the uterus.
Figure 3: (A) 2D imaging with a temperature controlled and close circuit ventilated transparent animal tray within the imaging chamber; (B, C) tray is fitted with nose cones to deliver anesthesia and can hold up to five mice.
Figure 4: Representative window panels taken from the analysis software to assist in data analysis. Please see text for explanation.
Figure 5: Detection of mCherry fluorescence co-localized with X-ray in longitudinal imaging sequence. Three mice with i.p. tumor are followed through time to assess i.p. tumor progression. Note that tumor progression may vary. Figure is a representative image of 3 mice with different rates of tumor progression and therefore varying tumor burden through time.
Figure 6: Correlation between i.p. tumor burden (top panel) and fluorescence/X-ray overlay image (bottom panel). About 32 days post injection of F2-mCherry ovarian cancer cells, 2D-imaging is performed and mice sacrificed to correlate actual tumor burden with the acquired image. Red arrows point to tumor burden.
Figure 7: Rotation data sets allowing multi-angle imaging and detection of tumors in Control (top panel), Paclitaxel treated (middle panel), and recurrent mice (bottom panel). Figure shows image of a single mouse per panel as it is rotated using the MARS system. Note that even in Control mice with significant tumor burden, tumor size can be underestimated depending on the angle the image was taken from.

Discussion

We describe a protocol to establish an i.p. human ovarian cancer animal model that mimics the clinical profile observed in patients. In addition, we describe the use of an animal rotation device that addresses the sensitivity limitation of 2D imaging. Taken together, these techniques can serve as platforms to discover novel compounds that can target chemoresistant recurrent ovarian cancer. In addition, such model can be used to understand the biology of cancer recurrence and progression.

Due to its retroperitoneal location, early-stage i.p. ovarian cancer xenografts are almost impossible to detect by physically examining the mouse. In most cases, once the disease can be palpated, the tumor burden is already significant and therefore limits the evaluation of treatment efficacy. The use of fluorescently labeled cells allows us to assess the establishment of i.p. tumor in real time and consequently identifying the optimum time to begin treatment. In a similar way, fluorescent-labeled xenografts allow monitoring of treatment response. It should be pointed-out however that i.p. tumors deeper than 1 cm are typically not detectable irrespective of the reporter system.

The use of human ovarian cancer stem cells [14,15,17,22] generates xenografts that mimic the clinical profile observed in patients. As a primary disease, the model is responsive to Paclitaxel but cessation of treatment eventually leads to chemoresistant recurrent disease. Introducing the cells through the uterine horns at the density specified in the Protocol section usually results in ovarian tumors within 10 days with a few peritoneal implants, and therefore mimics early-stage disease. The use of fluorescently labeled cells allows us to assess the establishment of i.p. tumor in real-time and consequently identifying the optimum time to begin treatment. In a similar way, fluorescent-labeled xenografts allow monitoring of response to treatment. If other types of cancer cell lines are used, ovarian or otherwise, it is possible that this profile may not be observed. When SKOV3 is used for example, it has been reported that the initial i.p. tumors are already resistant [23]. Nevertheless, if labeled with a reporter such as fluorescence, i.p. disease can be followed in real-time.

If other fluorescent reporter is used, it is important to perform initial imaging with a control (no tumor) animal. This will allow optimization of imaging protocol to achieve the best background to signal ratio. In our experience, nude mice typically have high background when imaged using the GFP acquisition settings.

It is important that cells injected intra-uterine are in single suspension to avoid the establishment of tumors in the uterus. It is also important to avoid scratching the uterine epithelial layer, which also facilitates engraftment of the cancer cells in the uterus thus producing an intra-uterine tumor instead of an i.p. disease. In addition, during data analysis, it is important to set the gamma value to 1. This ensures that the intensity of the images is linear and allows comparison between images.

During the acquisition of MARS images, it is important to ensure that the tubed end of the collapsible nosecone is in the nosecone recess. The nosecone serves as a point of contact for the mouse and is therefore required for obtaining precisely calibrated angles. For longer imaging protocols (i.e., longer than 1 hour), inject 100 μl of sterile saline subcutaneously to help prevent dehydration. Animal body temperature should
be maintained using warm airflow through the system at approximately 37°C. A limitation of the MARS system is that only one animal can be imaged at a time with a total run time of about 1 hour per animal.

In conclusion, we describe the establishment of an animal model that closely mimics ovarian cancer, both primary and recurrent disease. This model can be used to evaluate the efficacy of novel diagnostic or therapeutic modalities.

Disclosures

Publication fees for this article were partially sponsored by Bruker Corporation.

Acknowledgements

This study was supported by NIH grants RO1CA118678 and RO1CA127913, by the Sands Family Foundation, and the Discovery to Cure Program.

References